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Creating a Panel Label with Fusion and Inkscape 

 
 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 



Contents 
Fusion ς Starting the Label Frame ..................................................................................................................................................... 3 

Inkscape - Downloading and Installing ............................................................................................................................................ 14 

Inkscape - Starting an Inkscape Drawing ........................................................................................................................................ 18 

Inkscape ς Enable Mousewheel Zoom ............................................................................................................................................ 19 

Inkscape ς Importing DXF file .......................................................................................................................................................... 23 

Inkscape ς Using the Transform tool .............................................................................................................................................. 26 

Inkscape ς Using the Fill and Stroke tool ........................................................................................................................................ 28 

Inkscape ς Creating an Offset Rectangle......................................................................................................................................... 29 

Inkscape ς Setting Fill Color and Stroke .......................................................................................................................................... 30 

Inkscape ς Adding Text ................................................................................................................................................................... 31 

Inkscape ς Product Nameplate ....................................................................................................................................................... 33 

Inkscape ς Adding a Graphic ........................................................................................................................................................... 38 

Inkscape ς Printing the Label .......................................................................................................................................................... 42 

Cutting Out the Label ...................................................................................................................................................................... 43 

Fusion ς Completing the Frame ...................................................................................................................................................... 44 

Fusion ς Adding Rebar .................................................................................................................................................................... 51 

Fusion ς Applying a Material and Setting a Color ........................................................................................................................... 56 

Fusion ς Inserting a Decal ............................................................................................................................................................... 59 

Selecting Mouting Screws ............................................................................................................................................................... 66 

Fusion ς Inserting a McMaster-Carr part ........................................................................................................................................ 68 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 



Fusion ς Starting the Label Frame 

- click on the arrow for Document Settings and click on the Edit icon 

- if the Units are not inch (in), ouncemass, change it to that option and click OK 

- from the top File icon select Save and save the project startting with you ƴŀƳŜΣ ŦƻƭƭƻǿŜŘ ōȅ άψtŀƴŜƭ[ŀōŜƭέ, e.g. 

άWƻŜ.ŀǊōŜǘǘŀψtŀƴŜƭ[ŀōŜƭέ 

 

 

- right-click on the project name and select New Component 

- set the Name as your first name ŀƴŘ ƭŀǎǘ ƴŀƳŜ ƛƴƛǘƛŀƭ ŦƻƭƭƻǿŜŘ ōȅ άψ[ŀōŜƭCǊŀƳŜέΣ ŜΦƎΦ άWƻŜ.ψ[ŀōŜƭCǊŀƳŜέΣ ŀƴŘ ŎƭƛŎƪ OK. 

 

 

- select the Create Sketch tool and click on the Front plane 

 



- from the CREATE menu select Rectangle and Center Rectangle 

 

 

 

- click on the Origin to start the rectangle and drag the outline out 

- type 3.84, press the Tab key, type 1.425, and then press the Enter key 

The Tab key toggles between multiple values of an object, such as Height and Width, in this case. 

 

 

 

 

 



- click on the Construction Linetype icon to highlight it blue.  This should result in dashed lines being drawn. 

- select the Line tool and click on the center of the top edge of the rectangle and extend the line downward 

- type 0.155 and press the Enter key 

 

 

- start a new line at the bottom end of that just created and use a value of 0.38 

- continue creating lines one after the other using the values shown below starting with 0.503 

It is OK if the dimension lines look different.  The dimension values can be dragged to change their placement. 

 

 



- click on the Construction Linetype icon to removed the blue highlight.  This should result in solid lines being drawn. 

 

 

- select the Center Diameter Circle tool.  If it is not visible select it from the CREATE menu. 

- click on the bottom of the top line, drag the circle outward, and enter 0.125 

- create the same diameter circle at the bottommost point also 

 

 

 

 



- uncheck the Constraints option to reduce some clutter on the Sketch 

- use the Circle tool again to create two 0.625 diameter circles at the points shown.  Any points mentioned are at the end 

points of the vertical construction lines that were previously created. 

- use the Center Rectangle tool to create the two 0.20 x 0.925 rectangles at the points shown 

- use the Center Rectangle tool to create the one 0.75 x 1.015 rectangle at the point shown 

- check the Constraints option to bring the constraints back 

- click Finish Sketch 

What are all these crazy dimensions?  These are the perfect dimensions resulting from many years of panel development. 

 

 

 

 

 

 

 

 

 

 



- click on the Home icon at the View Cube 

- select the Extrude tool and click on the sketch 

- enter -0.08 (note the minus sign) for distance and click OK 

 

 

- zoom in to the top of the frame 

- select the Fillet tool.  If it is not visible, select it from the MODIFY menu. 

- click on the two top edges, which should highlight them blue 

- enter 0.05 and click OK 

 

 



- zoom in to the bottom of the frame 

- select the Fillet tool and click on the 4 inner edges of the bottom cutout, enter a value of 0.075, and click OK 

- as done with the top 2 corners add a 0.05 fillet to the bottom corners 

 

 

 

This should be the result of the design 

so far. 

At a later point this design will be 

modified further, but at this point we 

have enough to produce a label. 



- from the top left of the Fusion screen select Offset Plane from the CONSTRUCT menu 

 

 

- click on the face of the frame, enter -1.00 (note the minus sign) for Distance and click OK 

 

 

- select the Create Sketch tool and click on the Construction Plane 

 

 

 

 



- turn the View cube to access the rear of the frame 

- click on the arrows to the left to the Component and then to the left of the Sketches folder 

- right-click on each Sketch name and select Rename and rename as Frame and LabelDXF as shown 

 

 

- from the CREATE menu select Project / Include and Project 

 

 

 



- click on the rear face of the Frame.  Before clicking, when the mouse is over the face, red lines will appear as shown. 

- click OK 

 

 

- right-click on LabelDXF and select Export DXF 

 

 

 

 



- set the Units to Inch and click OK 

 

 

- ensure that Save to my computer is checked 

- make note of the save location and if desired, the location can be changed with the right Χ ƛŎƻƴ 

- click Save 

 

 

 

 

 

 



Inkscape - Downloading and Installing 

LƴƪǎŎŀǇŜ ƛǎ ŀ ŦǊŜŜ ŀƭǘŜǊƴŀǘƛǾŜ ǘƻ !ŘƻōŜΩǎ LƭƭǳǎǘǊŀǘƻǊΣ ǿƘƛŎƘ ƛǎ ƻƴƭȅ ŀǾŀƛƭŀōƭŜ ŀǎ ŀ ǇŀƛŘ ǎǳōǎŎǊƛǇǘƛƻƴ ƳƻŘŜƭΦ  !ōƻōŜ LƭƭǳǎǘǊŀǘor also 

uses about 2000 MB of disk space, as opposed to about 600 MB for Inkspace. 

This tutorial is based on using Inkscape version 1.4.3.  When you use this document there may be a later version of Inkscape 

available.  You can chose to install the latest version or version 1.4.3 to ensure it is identical to that used for this tutorial. 

This link, https://inkscape.org/release/inkscape-1.4.3/, will bring you to the page for version 1.4.3, as shown below.  One can 

choose to install the Linux version (for hard-core programmers), Windows, or Mac versions. 

 

 

- LŦ ǘƘƛǎ ƛǎ ŀ ǎŎƘƻƻƭ ƻǊ ōǳǎƛƴŜǎǎ ŎƻƳǇǳǘŜǊ ƛǘ Ƴŀȅ ōŜ άƭƻŎƪŜŘ Řƻǿƴέ ŀƴŘ ƴƻǘ ƘŀǾŜ ŀŘƳƛƴƛǎǘŀǘƻǊ ǇǊƛǾƛƭŜƎŜǎΦ  Lƴ ǘƘƛǎ ŎŀǎŜΣ ǎŜƭŜŎǘ the 

right side 64-bit option.  The left side allows installing the software from the Windows App Store. 

 

 

- If this is a school or business computer without administator privileges, select the right side Compressed archive option.  

Otherwise, the middle Windows Installer Package will provide an easier installation. 

A good strategy is to first try the Windows App Store or the Windows Installer Package.  If an error occurs or a message, such 

as needing administrator privileges, blocks the installation, then use the Compressed archive. 

 

https://inkscape.org/release/inkscape-1.4.3/


If the Windows App Store or Windows Installer Package was used successfully, skip a few pages and continue with the 

άLƴƪǎŎŀǇŜ - {ǘŀǊǘƛƴƎ ŀƴ LƴƪǎŎŀǇŜ 5ǊŀǿƛƴƎέ section. 

 

¢Ƙƛǎ ŀƴŘ ǘƘŜ ŦƻƭƭƻǿƛƴƎ ǘǿƻ ǇŀƎŜǎ ŎƻǾŜǊǎ ǘƘŜ ǳǎŜ ƻŦ ǘƘŜ /ƻƳǇǊŜǎǎŜŘ ŀǊŎƘƛǾŜΣ ǿƘƛŎƘ ŎƻǳƭŘ ōŜ ŎƻƴǎƛŘŜǊŜŘ ǘƘŜ άǇƻǊǘŀōƭŜέ ǾŜǊǎƛƻƴ 

ƻŦ ǘƘŜ ǎƻŦǘǿŀǊŜΦ  ! άǇƻǊǘŀōƭŜέ ƛƴǎǘŀƭƭŀǘƛƻƴ ŘƻŜǎ ƴƻǘ ŎƘŀƴƎŜ ƳŀƪŜ ŀƴȅ ŎƘŀƴƎŜǎ ǘƻ ŦƛƭŜǎ ƛƴ ǘƘŜ ƻǇŜǊŀǘƛƴƎ ǎȅǎǘŜƳ ǘƘŀǘ ǿƻǳƭŘ ƴŜŜŘ 

administrator privileges. 

 

If the Compressed archive option was selected, a download should start and the Downloads icon will indicate the progress. 

 

 

- in your Downloads folder, right click on the inkscape file just downloaded and select 9ȄǘǊŀŎǘ !ƭƭΧ 

 

 

 

 

 

 

 



- click on Extract 

 

 

- if desired, delete the original zipped file.  It is not needed any longer. 

- double click on the inkscape folder just created. 

 

 

- double click on the inkscape folder 

 

 



- to run the program now or in the future double click on Run Inkscape !.bat 

 

 

- if this window shows, click Run 

 

 

 

 

 



Inkscape - Starting an Inkscape Drawing 

- select the Time to Draw tab 

- click New Document 

 

 

- from the Edit menu select Preferences, which is near the bottom of the menu list 

 

 

 

 

 

 

 



Inkscape ς Enable Mousewheel Zoom 

By default Inkscape uses the Mousewheel for scrolling (Vertical pan).  The following instructions will allow the Mousewheel to 

control Zoom In/Out, which is the same as in Fusion. 

 

- in the left side section, select the Interface group and select Keyboard 

- select the Modifiers tab and select the Canvas group 

 

 

- select the Canvas zoom row and click on Ctrl to deactivate the Ctrl Modifier 

 

 

- select the Vertical pan row and click on Ctrl to activate the Ctrl Modifier.  The result is that in the right screenshot. 

 



- in the left side section, select the Behavior group and select Steps 

- for Arrow key move by:  select in as the units and set the value to 0.0010 

- close the Preferences window 

 

 

- from the File menu select 5ƻŎǳƳŜƴǘ tǊƻǇŜǊǘƛŜǎΧ, which is near the bottom of the menu list 

 

 

 

 

 

 

 

 

 

 



- select the Display tab 

- change the Format units to in and the Format to US Letter (in the US group) 

- change the Display units: to in 

- set the Orientation to Landscape (2nd option) 

- set Scale to 1.000000 

- close the window 

 

 

Note that the top ruler of the Inkscape canvas should show the page from 0 to 11 

 

 

 

 

 

 

 



- from the File menu select {ŀǾŜ ¢ŜƳǇƭŀǘŜΧ 

 

 

- set the Name to US Units and click Save 

 

 

This does not need to be checked, but for information only, Inkscape creates a folder in AppData\Roaming for Templates and 

Preferences. 

 

 



Inkscape ς Importing DXF file 

- from the File menu select LƳǇƻǊǘΧ 

 

 

- use dropdown list to select Downloads or another location where the DXF file is 

 

 

- select LabelDXF.dxf and click Open 

 



- check the Read from file option 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 



- click on the Selector tool (arrow icon) and click on the DXF drawing just imported and drag it to the right, as shown on the 

right.  The position is not critical.  It is just on the sheet. 

 

 

 

Depending on the orientation of the bezel in Fusion or the way the Sketch was created, the DXF may be rotated or mirrored. 

- if the sketch is rotated (as it is here) or flipped say ά²Ƙŀǘ ǘƘŜ ǎƛƎƳŀΗέ and on the right side of the Inscape screen use the 

down arrow to select the Transform tool 

- click on the Sketch drawing to select it and on the right side of the Inkscape screen use the down arrow and select Transform 

 



Inkscape ς Using the Transform tool 

 

- if the sketch needs to be rotated select the Rotate tab, enter 180 for the Angle and click the Apply button 

 

 

- if the Sketch needs to be flipped, select the Scale tab 

- if the Sketch needs to be flipped vertically change the Height value from 100 to -100 (note the minus sign) 

- if the Sketch needs to be flipped horizontally change the Width value from 100 to -100 (note the minus sign) 

- click the Apply button 

 

 

 

 

 

 

 



- right click on the sketch and select Duplicate. 

 

 

 

- for the Transform tool select the Move tab and change the Horizontal value from 0.000 to 2.000.  The value of 2.000 is not 

critical.  It is just to move the duplicated object away from the original. 

The result is on the right. 

 

 

 

 

 

 

 

 

 

Inkscape has both a Duplicate and 

Clone feature. 

The Duplicate feature creates an 

άƛƴŘŜǇŜƴŘŜƴǘέ copy of the object 

that can be edited later to be 

different from the original. 

The Clone feature creates a άƭƛƴƪŜŘέ 

copy of object.  When the original 

object is editted, all clones will match. 



Inkscape ς Using the Fill and Stroke tool 

- on the right side of the Inkscape screen use the down arrow and select Fill and Stroke 

 

 

- select the Stroke style tab, ensure the units are in, and change Width to 0.005 

 

 

- select the Node ǘƻƻƭ ƛƴ ǘƘŜ ƭŜŦǘ ǎƛŘŜ άǘƻƻƭ ōƻȄέ ŀƴŘ ŎƭƛŎƪ ƻƴ ǘƘŜ small circle.  Change the Width to 0.010 to increase the width 

of that circle only.  Press the Ctrl and z keys (Ctrl+z) to unde this change. 

 

Note that this only affected the left 

side object because it was selected.  

The right side object did not change. 

One can switch between the 

Selector and Node tools as needed. 



Inkscape ς Creating an Offset Rectangle 

- hold the Space key and click anywhere on the Canvas to pan the page up.  One can also use the right-side or bottom scroll 

bars, but using the Space key to pan with the mouse is convenient. 

- select the Node tool and click on the rectangle to select it 

- right-click on the rectangle indicated, and select Duplicate 

 

 

 

- on the right side of the Inkscape screen use the down arrow and select Path Effects 

- click on the new down arrow and select Offset 

 

 

 

 



- ensure that Live update is checked 

- change Unit to in and change Offset to 0.05 and press the Enter key.  An outer rectangle should appear as below. 

 

 

 

Inkscape ς Setting Fill Color and Stroke 

- select Fill and Stroke and select the Fill tab 

- select the Flat color icon 

- type 100 for the Saturation value and 50 for the Luminance value and press the Enter key 

The rectangle should be filled in red.  The Hue value (before Saturation) is 0 by default, but the value can be changed to adjust 

the color.  The Luminance value, which was changed to 50 can be adjusted to darken or lighten the color. 

 

 

- select the Stroke Paint tab and click on the x icon to remove the outline of the red ractangle 

 



Inkscape ς Adding Text 

- select the Text tool and set the Font Family to Arial, the Font style to Bold, and the Font size to 14 pt 

- and click on the bottom left corner of the rectangle 

 

 

- type the desired text.  The text may not show because the color is set to red. 

- select Fill and Stroke and select the Fill tab 

- select the Flat color icon,  type 0 for the Luminance value and press the Enter key, which sould make the text black. 

- if needed change the Text size if needed and there is also a Bold Condensed and other options.  The goal is to have the text 

contained in the inner rectangle with some space aroound the text. 

 

 

- select the Selector tool, click on the text and move it to the center of the rectangle 

 



- select the Node tool and click on the inner rectangle 

- select the Stroke paint tab, select the Flat color option, set Saturation to 100 and Luminance to 42.  This will make the inner 

rectangle only slightly visible to serve as a guide if changing text. 

 

 

 

 

- scroll down to the 2nd rectangle and perform the same operations that were done with the 1st rectangle starting with 

άInkscape ς Creating an Offset RectangleέΦ  ¢Ƙƛǎ ǘŜȄǘ ǿƛƭƭ ōŜ ǎŜǘ ǘƻ άTEMP (C)έ ŦƻǊ ǘŜƳǇŜǊŀǘǳǊŜ ƛƴ ŘŜƎǊŜŜǎ /Φ 

 

 

 

 

 

 

 

 

 

 

 

 



Inkscape ς Product Nameplate 

9ǾŜǊȅ ƛƴŘǳǎǘǊƛŀƭ ǇǊƻŘǳŎǘ ǎƘƻǳƭŘ ƘŀǾŜ ŀ ƴƛŎŜ άƴŀƳŜǇƭŀǘŜέ ƛƴŘƛŎŀǘƛƴƎ ǘƘŜ ŎƻƳǇŀƴȅ ƴŀƳŜΣ ǇǊƻŘǳŎǘ ƴŀƳŜ ŀƴŘ ƳƻŘŜƭΣ ŜǘŎΦ  LƴǎǘŜŀŘ 

of creating a separate nameplate, it can become part of the label frame and this is the reason for the bottom rectangle. 

 

- scroll down to the bottom rounded rectangle 

- select the Node tool and select the rounded rectangle 

- right-click on the rounded rectangle and select Duplicate 

 

 

- from the Object menu select Lower to Bottom.  Some software will call the the bottom of the Z-Order.  This will cause 

ǎƻƳŜǘƘƛƴƎ ǾƛǎƛōƭŜ ǘƻ ƘŀǇǇŜƴΣ ōǳǘ ǿƛƭƭ ǇƭŀŎŜ ǘƘŜ ƴŜǿ ǊŜŎǘŀƴƎƭŜ άǳƴŘŜǊέ ǘƘŜ ƻǊƛƎƛƴŀƭΦ  The purpose of this is to keep the original 

rectangle visible to help ensure that text is placed properly. 

 



- perform an offset of 0.05 as was done previously for the two upper rectangles.  If the Offset settings are not visible select the 

Path Effects tab and use the down arrow to select the Offset function. 

 

 

- select Fill and Stroke and select the Fill tab 

- select the Flat color icon, type 100 for the Saturation value and 50 for the Luminance value and press the Enter key 

 

 

- select the Stroke Paint tab and click on the x icon to remove the outline of the red ractangle 

 

 



- select the Text tool and click on the location indicated.  This does not need to be accurate.  It can be repositioned later. 

- type UF6, which may not show at first 

- select Fill and Stroke and select the Fill tab 

- select the Flat color icon, type 0 for the Luminance value and press the Enter key, which should make the text black. 

- ensure that the Font, Font style, and Size are set as shown 

 

 

- select Stroke paint and select the x to remove any outline around the text 

 

 

- select the 6 in the text and click on the Subscript button 

 

 

 

 



- select the Text tool and click on the location indicated.  This does not need to be accurate.  It can be repositioned later. 

- type Centrifuge, then press the Enter key, and then type Controller.  If the text does not appear on two lines click on the Line 

spacing icon and set the value to 1.00.  This value can be changed to set the spacing between multiple lines of text. 

 

 

- click on the Text alignment icon and select the Align center option 

 

 

The 6 subscript looks a little wimpy. 

- select the 6 and then change the size to 11 

 

 



- select the Selector tool 

- click on the text and move it so it is centered at the bottom, as hown. 

- if the text does not fit, one can drag the handle, indicated by the blue arrow, to the left to compress the text. 

Note how there is some spacing between the edges of any letters and the inner rounded rectangle.  The inner rectangle 

represents the window in the 3D printed frame.  Because it may be difficult to perfectly align the printed label with the frame 

there needǎ ǘƻ ōŜ ǎƻƳŜ ǎǇŀŎƛƴƎ ǎƻ ǘƘŀǘ ƴƻ ǘŜȄǘ ƛǎ ŎƻǾŜǊŜŘ ōȅ ǘƘŜ ŦǊŀƳŜΦ  Lǘ ŀƭǎƻ ŘƻŜǎƴΩǘ ƭƻƻƪ ƎƻƻŘ ƛŦ ŀƴȅ ǘŜȄǘ ƛǎ ǊƛƎƘǘ ŀǘ ǘƘŜ ŜŘƎŜ 

of the frame. 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 



Inkscape ς Adding a Graphic 

A Google Images search was performed for uranium hexaflouride molecule, as shown below. 

- hold the Shift, Windows, and s keys to start a screen shot and drag the selection rectangle around the larger molecule image 

ƻƴ ǘƘƛǎ ǇŀƎŜΦ  ¸ƻǳ ŘƻƴΩǘ ƘŀǾŜ ǘƻ ǇŜǊŦƻǊƳ ǘƘŜ ǎŜŀǊŎƘ ƛƴ DƻƻƎƭŜΦ  ¢Ƙƛǎ ǎƘƻǳƭŘ ŎƻǇȅ ǘƘŜ ƛƳŀƎŜ ǘƻ ǘƘŜ ŎƭƛǇōƻŀǊŘΦ 

 

 

- zoom out using the mousewheel and press the Ctrl and v keys (Ctrl+v) to paste the image on the Inkscape canvas. 

- hold the Ctrl key while dragging the bottom right resize arrow to resize the image to fit on the label. 

Note that depending on the zoom value when viewing this document or the source of the image, it may be larger or smaller 

ǘƘŀƴ ǎƘƻǿƴΦ  ¢ƘŜ ƴŜȄǘ ǎǘŜǇǎ ǿƛƭƭ ŘŜƳƻƴǎǘǊŀǘŜ ǎŎŀƭƛƴƎ ƻŦ ǘƘŜ ƛƳŀƎŜΦ  LŦ ƻƴŜ ǿƛǎƘŜǎ ǘƻ ǳǎŜ ŀƴ ƛƳŀƎŜ ŦƛƭŜΣ ǎŜƭŜŎǘ LƳǇƻǊǘΧ ŦǊƻƳ ǘhe 

File menu. 

 



- zoom in to the label and resize again if needed and move the image as shown 

- click on the arrow to reveal the tool list and select Trace Bitmap 

 

 

- ensure the image is selected and that Brightness cutoff is selected and Invert image is checked 

- increase the Threshold value until the Previes shows the area of the image as fully white and the surrounding area as black. 

- click the Apply button, which should cause the region around the image to turn black, as shown in the lower insert image. 

 

 



- select Fill and Stroke and select the Fill tab 

- select the Flat color icon, change the Saturation value to 100 and the Luminance value to 50, which should cause the area 

around the graphic to match the surrounding color. 

 

 

- zoom out, admire your creation, and save your project using Save from the File menu 

- the copy on the right can remain, but it desired it can be selected and deleted 

 



- from the File menu select 9ȄǇƻǊǘΧ 

bƻǘŜ ǘƘŀǘ ǘƘŜǊŜ ƛǎ ŀ tǊƛƴǘΧ ƛǘŜƳ ōŜƭƻǿ 9ȄǇƻǊǘΣ ōǳǘ ƛǘ Ƙŀǎ ōŜŜƴ ŦƻǳƴŘ ǘƘŀǘ ǇǊƛƴǘƛƴƎ ŦǊƻƳ LƴƪǎŎŀǇŜ Ƙŀǎ ǎƻƳŜ ōǳƎǎ ǿƘŜǊŜ ƛƳŀƎŜǎ 

may be cropped. 

 

 

 

 

The right side of the Inkscape screen will show the Export 

options. 

- ensure that the Single File tab is selected and the Page 
option is selected. 

- near the bottom change the output type to PDF (*.pdf) 

- the bottom Path box should show the folder the PDF file will 
be saved in.  If desired, click on its folder icon to change the 
file location. 

- click Export at the bottom 

 

If this is being done as a class assignment 

you are done.  You will be submitting the 

PDF just created and a screenshot of the 

Inkscape screen. 

If this is for a project, continue with this 

document. 



Inkscape ς Printing the Label 

- open the PDF file in Chrome, as shown below, and click on the Printer icon 

 

 

- select the Destination (Printer) 

- change the Scale to Custom and 100 and click the Print button 

 



Cutting Out the Label 

 

- if desired, spray both sides of the label with an acrylic clear spray or apply clear tape over the label 

- using an X-Acto knife (remember Do Not Run with an X-Acto knife) and a proper cutting surface, cut around any knob or 

switch holes and hole locations. 

- continue cutting the outline, just slightly inside the outer reactangle. 

- the label can then be secured behind the 3D printed frame 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 



Fusion ς Completing the Frame 

- use the Home icon at the View Cube to achieve the below view 

- click on the eye icon for LabelDXF to hide the Sketch 

 

- from the MODIFY menu select Chamfer and ensure that Tangent Chain is checked 

- click on each of the front edges of each top rectangle to turn them blue 

- click on an edge of the bottom rounded rectangle, which should turn all its edges blue 

- set the chamfer value to 0.05 and click OK 

 



- select the Create Sketch tool and click on the front face of the frame 

 

 

 

- zoom to a view similar to that below and rename the Sketch to Edges 

- select the Line tool and click on the Linetype Construction icon to highlight it blue 

- move the mouse along the left edge of the frame until the blue triangle appears and then click at that point to start the line 

The blue triangle indicates that the mouse is at the center of an edge.  For this example it should be on the axis line, but for 

future designs it may not be. 

 

 

 



- extend the line to the right and when the other edage is reached an x should appear 

- click on that point to finish the line 

 

 

 

- note that there is a triangle near each end of the line to indicate that it starts and ends at center points 

- click on the Linetype Construction icon to turn off the blue highlighting 

- from the CREATE menu select Center Rectangle 

 

 

 

 

 

 



- click at the center of the construction line that was just created and extend the rectangle downward 

- type 3.22 for the height, press the Tab key, type 1.15 for the width, and press the Enter key 

- click Finish Sketch 

The width was chosen to make the region around this rectangle as large as possible without intersecting any holes or chamfers 

ŀǊƻǳƴŘ ƘƻƭŜǎΦ  bƻǘŜ Ƙƻǿ ǘƘŜǊŜ ƛǎ ǎǘƛƭƭ ŀ ǎƳŀƭƭ ŀƳƻǳƴǘ ƻŦ ǎǇŀŎŜΣ ǿƘƛŎƘ ƘŀǇǇŜƴǎ ǘƻ ōŜ лΦлмуέ ƘŜǊŜΣ ōŜǘǿŜŜƴ ǘƘŜ ŎƘŀƳŦŜǊ ƻŦ ǘƘŜ 

large bottom rectangular hole and this rectangle. 

The height was chosen to ensure the top and bottom smal mounting holes are between the rectangle and the top or bottom 

edges of the frame. 

 

 

 

 

 

 

 

 



- click on the Home icon at the View Cube 

- select the Extrude tool and click on the region between the rectangle just created and the outer edge 

- ensure that the Operation is set to Join 

- enter 0.07 for distance and click OK 

 

 

- from the MODIFY menu select Chamfer and select the edges of the inner edges of the extruded section and the outer edges 

- enter a value of 0.05 

 










































